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 1 Algemeen

 1.1 Voorwoord

Deze handleiding omschrijft de handelwijze voor het updaten van de software van regelsystemen 
van het type HCS3000.
De omschrijving betreft het gereedmaken van het HCS3000-systeem voor eerste gebruik en/of het 
upgraden van de regelsoftware naar een nieuwere versie.

De handelwijze voor het updaten heeft betrekking op softwareversie v1.10.67 en hoger en v1.11.12 
en hoger.

Deze technische handleiding is geschreven als naslagwerk voor de toepassing van de omschreven 
library-onderdelen in combinatie met CoDeSys 2.3.

Waar in de handleiding HCS-regelaar genoemd wordt, heeft deze informatie betrekking op regelaars 
van het type HCS3100, HCS3050 en/of HCS3200.

Uitgegaan wordt van kennis betreffende het gebruik van CoDeSys en de HCS3000 regelaars.
Waar in de handleiding gesproken wordt over een PC, wordt een PC of Laptop-PC bedoeld.

Wilt u meer informatie over het gebruik van de in deze handleiding genoemde hardware en/of 
software, neemt u dan contact met ons op.

 1.2 Opmerking

Deze technische handleiding is onder voorbehoud en kan worden gewijzigd zonder voorafgaande 
kennisgeving.

Alle rechten voorbehouden. Niets uit deze handleiding mag worden gefotokopieerd, gescand 
aangepast of vertaald of anderzijds geheel of gedeeltelijk verveelvoudigd worden zonder 
voorafgaande schriftelijke toestemming, behalve voor zover dat is toegestaan onder het 
auteursrecht. Wijzigingen en fouten voorbehouden. 

Let op!!!!   Bij het vervangen van het besturingssysteem van de regelaar gaat 
de op de regelaar aanwezige data verloren.
Updaten van de regelaar geschiedt geheel voor eigen risico.

Indien u een bestaande regelaar wilt updaten vanaf een oudere versie, met behoud van 
project-data, kunt u contact opnemen met HCS Building Automation.

Na het vervangen van de systeemsoftware kan voor het programmeren van de regelaar gebruik 
gemaakt worden van de template welke met het installeren van de target meegeïnstalleerd wordt.

In deze handleiding wordt er van uitgegaan dat de regelaar het standaard IP-adres (10.28.0.1) heeft, 
waarmee deze door HCS Building Automation geleverd wordt en dat er een netwerkverbinding 
aanwezig is tussen de PC en de Ethernetpoort aan de linker zijde van de regelaar.

 1.3 Te gebruiken programma's

Voor het uitvoeren van de upgrade, beschreven in deze handleiding, moeten handelingen uitgevoerd
worden op het bestandssysteem van de regelaar door middel van een FTP-sessie.

Voor het maken van een FTP-sessie naar de regelaar kan gebruikt gemaakt worden van verkenner.
Eenvoudiger en handiger is echter om een FTP-client te gebruiken zoals bijvoorbeeld Filezilla.
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Dit programma is gratis te downloaden van het Internet.
Nadere informatie over het starten van een FTP-verbinding met Filezilla is te vinden in 1.3.1 Gebruik 
van FileZilla.

Verder moeten systeemcommando's uitgevoerd worden om de regelaar opnieuw op te starten of om 
informatie uit de regelaar te lezen via een Telnet-sessie.

Voor het starten van een Telnetsessie kan gebruik gemaakt worden van het programma PuTTY. Dit 
programma is gratis te downloaden van het internet.
Nadere informatie over het starten van een Telnet-verbinding met PuTTY is te vinden in 1.3.2
Gebruik van PuTTY.
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 1.3.1 Gebruik van FileZilla

Na het installeren kan FileZilla gestart worden.

Om een verbinding tot stand te brengen moet in de bovenste regel van het programma een aantal 
gegevens ingevuld worden.

Host: Hier moet het IP-adres van de regelaar ingevuld worden 
(bijvoorbeeld 10.28.0.1)

Gebruikersnaam: ftp
Wachtwoord: ftp
Poort: 21

Na het invullen kan verbinding gemaakt worden door de knop ‘snelverbinding’ aan te klikken.

Na een geslaagde verbinding is in het venster ‘Externe site’ te zien hoe de inhoud van de regelaar is.
De HCS3000-regelaars hebben een schijf A: met daarin een subdirectory met de naam HCS3000.

In het venster ‘Lokale site’ kan de een locatie op de PC gekozen worden waar de bestanden 
vandaan of naartoe gekopieerd kunnen worden.
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 1.3.2 Gebruik van PuTTY

Na het starten van PuTTY kan een Telnet-sessie met de regelaar gestart worden.
Om dit te doen, moeten een aantal instellingen in het programma gemaakt worden.

Connection type: Telnet
Host Name: Het IP-adres van de regelaar
Port: 23 (wordt automatisch veranderd bij kiezen van Connection 

Type)

Om de verbinding tot stand te brengen moet ‘Open’ aangeklikt worden.

Vervolgens opent een scherm waarin gevraagd wordt om in te loggen.
Hierbij moet gebruikersnaam en wachtwoord opgegeven worden.
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Username: tel
Password: tel

Beide moeten bevestigd worden met enter.

Telnet werkt met een commandostructuur welke veel lijkt op MSDOS.
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 2 Opbouw van de software
In de regelaar is de software in het geheugen opgebouwd uit verschillende onderdelen.
Een deel van de onderdelen is aanwezig op het bestandssysteem van de regelaar en kan door de 
gebruiker aangepast worden.

De werking van de verschillende software-onderdelen wordt uitgelegd in dit hoofdstuk.

Tussen versie 1.10 en 1.11 bestaan verschillen in de opbouw.
In de volgende twee afbeelding zijn deze verschillen zichtbaar gemaakt.

De versies van RTS, projectsoftware, parameterbestanden, systeembestanden, bootproject en 
standaardvisualisaties1 dienen identiek te zijn.

Indien er een verschil bestaat tussen de softwareversies van bovengenoemde onderdelen, kan 
onvoorspelbaar gedrag optreden.

De versie van RTOS is onafhankelijk van de versie van de overige softwaredelen.

 2.1 RTOS Real Time Operating System

De HCS3000-regelaar is uitgerust met een RTOS die alle taken van de regelaar uitvoert en de 
basisfunctionaliteiten van de regelaar behandelt.
De RTOS is het equivalent van de BIOS van een PC.

Tot de basisfunctionaliteiten van de regelaar behoren onder andere de werking van o.a. de 
communicatiepoorten, FTP-server, Webserver en Telnet-server.

Verder is de RTOS verantwoordelijk voor de werking van het bestandssysteem en de aanroep van 
het opstartbestand autoexec.bat.

Dit bestand zorgt onder andere voor het opstarten van het  RTS, externe micro SD kaart2 en/of 
tweede Ethernetpoort3.

1 Alleen bij softwareversie 1.11

2 Alleen bij HCS3200

3 Alleen bij HCS3200
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Een eventuele foute handelwijze tijdens het upgraden van de RTOS kan 
onherstelbare schade toebrengen aan de regelaar.

Indien gewenst kan het upgraden van de RTOS door HCS Building Automation uitgevoerd 
worden.

 2.2 RTS Runtime System

De HCS3000-regelaar is voorzien van een runtime system, die de werking van de projectsoftware, 
toetsenbord en display4 en de aansturing van in- en uitgangen mogelijk maakt.

Tevens maakt het RTS de communicatie met de programmeetool CODeSys mogelijk.

Het RTS is het equivalent van het besturingssysteem van een PC.

De bestandsnaam van het RTS in het bestandssysteem is HCS3000.exe.

In het bestand autoexec.bat dient minimaal een aanroep te staan naar HCS3000.exe om het RTS te 
starten.

 2.3 Parameter- en systeembestanden

 2.3.1 Parameterbestanden

In het bestandssysteem van de regelaar zijn de parameterbestanden aanwezig, welke door de 
projectsoftware regelmatig (of indien gewenst handmatig) gegenereerd worden als backup van de 
parameters van de regelsoftware.

Deze bestanden worden door de regelaar gebruikt om tijdens het opstarten van de regelaar de laatst
bekende parameters te kunnen laden.

 2.3.2 Systeembestanden

Het bestandssysteem bevat een aantal systeembestanden, welke nodig zijn voor het opstarten van 
de regelaar.

Verder kunnen systeembestanden ook basisinformatie bevatten van de regelaar.
Onder deze basisinformatie vallen o.a. de IP-adressen en naam van de regelaar, alsook instellingen 
voor automatische tijdsynchronisatie e.d.

 2.4   Visualisatie

Afhankelijk van de softwareversie is er een verschil aanwezig in de opbouw van de visualisatie van 
de regelaar.

 2.4.1 Visualisatie softwareversie v1.10

In softwareversie 1.10 is de volledige visualisatie van het project gemaakt in de projectsoftware en 
wordt deze visualisatie zichtbaar gemaakt in de Webbrowser door middel van een Java-applet.

De visualisatie is onderdeel van de projectsoftware en wordt samen met de projectsoftware door 
CoDeSys naar de regelaar gestuurd.

4 Alleen bij HCS3100 en HCS3200.
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 2.4.2 Visualisatie softwareversie v1.11

Softwareversie 1.11 maakt alleen voor de weergave van de principeschema's gebruik van de Java-
applet.

De visualisatie met de principeschema's is onderdeel van de projectsoftware en wordt samen met de
projectsoftware door CoDeSys naar de regelaar gestuurd.

De parameters, alarmlijsten en andere informatie worden gegenereerd door de regelaar en maken 
geen gebruik van Java JRE. 
Dit maakt de bediening van de regelaar met een mobiel apparaat (smartphone en/of tablet) mogelijk.

De standaardvisualisaties, welke zorg dragen voor de weergave van parameters, overzicht- en 
alarmlijsten staan standaard in het bestandssysteem van de regelaar.

 2.5 Projectsoftware

De projectsoftware bevat de softwaregroepen, welke nodig zijn om de onderdelen van de HVAC-
installatie aan te sturen.
Denk hierbij aan schakelklokken, radiator-, lucht-, boiler- en ketelgroepen.

Verder bevat de projectsoftware de visualisatie voor de aanwezige softwaregroepen5.

De projectsoftware wordt met de programmeertool CoDeSys naar het werkgeheugen van de 
regelaar verstuurd.

Voor het maken van de projectsoftware dient gebruik gemaakt te worden van een target en template 
van dezelfde softwareversie, welke ook in de regelaar aanwezig is.

Ook kan tijdens het opstarten de projectsoftware vanuit het bootproject (indien aanwezig) door de 
RTS in het werkgeheugen geladen en gestart worden.

Tijdens het opstarten van de projectsoftware zullen de parameters geladen worden vanuit de 
parameterbestanden.
Indien geen parameterbestanden aanwezig zijn (of van een afwijkende softwareversie), dan zal de 
betreffende groep gestart worden met de fabrieksinstellingen.

 2.6 Bootproject

Het bootproject is een exacte kopie van de projectsoftware, welke bestaat in het bestandssysteem 
van de regelaar.

Tijdens het opstarten van de RTS zal de inhoud van het bootproject in het werkgeheugen geladen en
gestart worden.

5 In softwareversie 1.10 alle visualisaties, in softwareversie 1.11 alleen de principeschema's
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 3 Gereedmaken van regelaar voor eerste gebruik
Controleer voorafgaande aan het programmeren van een HCS-regelaar altijd de softwareversie van 
deze regelaar. Deze versie dient overeen te komen met de versie van de in CoDeSys geïnstalleerde 
target.

Indien de softwareversie van de regelaar gewijzigd dient te worden, kunnen de in dit hoofdstuk 
omschreven stappen gevolgd worden.

Tijdens het gereedmaken voor eerste gebruik wordt het besturingssysteem van de regelaar 
vervangen.

Let op!!!!   Het besturingssysteem mag niet vervangen worden als deze nog 
actief is.
Vervangen van een actief besturingssysteem kan permanente schade 
opleveren aan het systeem.

Tijdens deze procedure gaat alle data in de regelaar verloren!

Om de procedure uit te voeren dient gebruik gemaakt te worden van een FTP-verbinding om 
bestanden op het bestandsysteem van de regelaar te plaatsen, verwijderen en/of vervangen.
Voor het uitvoeren van een herstart en andere systeemacties kan gebruik gemaakt worden van een 
Telnet-verbinding.

De werking van de programma's Filezilla en PuTTY, die hiervoor gebruikt kunnen worden, staan 
omschreven in hoofdstuk 1.3 Te gebruiken programma's.

 3.1 Uitschakelen van het besturingssysteem

Om het besturingssysteem van de regelaar uit te schakelen dienen de volgende stappen uitgevoerd 
te worden:

• Open een FTP-sessie ('Host' is 10.28.0.1, gebruikersnaam en wachtwoord zijn beide ftp, 
uitgaande van het standaard instellingen van de regelaar).

Open de directory A en hernoem autoexec.bat naar autoexec.ba, of verwijder het bestand.

• Sluit de FTP-sessie door het programma te sluiten.

• Open een Telnetsessie ('Host' is 10.28.0.1, gebruikersnaam en wachtwoord zijn beide tel, 
uitgaande van het standaard instellingen van de regelaar).

Toets in de telnetsessie het commando 'reboot' in en sluit af met enter om de regelaar te 
herstarten.

Door het herstarten van de regelaar zal de verbinding met de Telnetsessie verbroken 
worden.

De regelaar is nu opgestart, zonder dat het besturingssysteem actief is, en is gereed voor de 
volgende handelingen.

 3.2 Formatteren van de regelaar
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Na het uitschakelen van het besturingssysteem dient de inhoud van de regelaar gewist te worden.
Vanwege schrijfbeveiligingen op enkele bestanden dient hiervoor de A-schijf van de regelaar 
geformatteerd te worden.

• Open hiervoor een Telnetsessie en typ 'format a: /plp'.
Let hierbij op dat tussen a: en /plp een spatie dient te staan.
Bevestig met enter.

De regelaar zal vragen om een bevestiging van de keuze.
Na indrukken van de toets 'Y' zal de A-schijf geformatteerd worden.
Dit zal enige tijd in beslag nemen.

• Indien het formatteren gereed is, zal de regelaar hiervan een melding maken.

Let op!!!!   Maak de regelaar op dit moment niet spanningsloos!!!!

Indien de regelaar spanningsloos gemaakt wordt, zal het huidige IP-adres 
10.28.0.1 verloren gaan en kan de regelaar niet meer onder dit adres benaderd worden!
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• Om te controleren of het formatteren op de juiste manier is uitgevoerd, kan het commando 
'chkdsk' gebruikt worden.
Deze geeft de informatie van de A-schijf weer.

Let hierbij op dat in de eerste regel PLP aangegeven wordt.

Indien de tekst 'PLP' niet weergegeven wordt, dient het formatteren opnieuw 
uitgevoerd te worden.
Let hierbij op de spatie voorafgaande aan '/PLP'.

• Sluit de Telnet-sessie door het afsluiten van het programma PuTTY.

 3.3 Schrijven van besturingssysteem in regelaar

Nu de schijf van de regelaar leeg is, kan de image naar de regelaar gekopieerd worden.

• Open opnieuw een FTP-sessie en ga naar de directory A: van de regelaar.
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• Ga in het venster 'Lokale site' naar de directory 'C:\Program Files\3S Software\CoDeSys 
V2.3\Image HCS3000 V1.11.yy'. 
Dit is de directory waarin de inhoud van een 'schone regelaar' staat.
Hierbij staat yy in de directorynaam voor het buildnummer van de target.
De huidige buildversie is 16, zodat de volledige naam eindigt op '…....\CoDeSys V2.3\Image 
HCS3000 V1.11.16'. 

• Ga in het venster 'Externe site' naar de inhoud van A.

• Upload eerst het bestand 'chip.ini' van de image naar de regelaar, zodat na een eventuele 
spanningsuitval de regelaar het IP-adres 10.28.0.1 weer toegewezen krijgt.
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• Upload vervolgens de rest van de image naar de regelaar, met uitzondering van het bestand 
'chip.ini'. Dit uploaden zal enige tijd in beslag nemen. 

 3.4 Opstarten van de regelaar

Na het schrijven van de image moet de regelaar opnieuw opgestart worden.
Volg hiervoor de volgende procedure.

• Open een Telnet-sessie en herstart de regelaar met het commando 'reboot' of maak de 
regelaar kortstondig spanningsloos. 

De regelaar zal hierna opstarten met het hiervoor geïnstalleerde besturingssysteem.

Na het opstarten is de regelaar klaar voor gebruik en kan met CoDeSys voorzien worden van de 
benodigde projectsoftware.

Let hierbij op dat de projectsoftware van dezelfde softwareversie is als die van het 
besturingssysteem van de regelaar.
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 4 Upgraden van regelaar
Indien een bestaande regelaar geüpgraded dient te worden, zal een deel van de  data bewaard 
moeten blijven.
Denk hierbij bijvoorbeeld aan instelparameters van schakelklokken en regelgroepen en 
systeeminstellingen.

Upgraden met (grotendeels6) behoud van instellingen is alleen mogelijk tussen gelijkwaardige 
versies.

Een upgrade vanaf versie v1.10 is niet in alle gevallen mogelijk, omdat de te volgen procedure sterk 
afhankelijk is van de orginele softwareversie.
Ook indien het een upgrade betreft welke binnen versie v1.10 blijft.
In sommige gevallen dient de software opnieuw gemaakt te worden.

Neem voor het upgraden van softwareversie v.1.10 contact op met HCS Building Automation voor 
nadere informatie over de te volgen procedure.

De volgende hoofdstukken beschrijven het upgraden van de regelaar in softwareversie v1.11.

Indien gewenst kunt u de upgrade van de projectsoftware en/of het 
besturingssysteem ook door HCS Building Automation uit laten voeren.

 4.1 Algemene omschrijving van upgrade

Afhankelijk van de orginele en de gewenste softwareversie kunnen een deel van de instelparameters
verloren gaan en dienen handmatig opnieuw ingesteld te worden.

Indien een regelaar geüpgraded wordt, dienen een aantal basisstappen gevolgd te worden.

• Van de huidige data in de regelaar dient een volledige kopie gemaakt te worden.
Een deel van deze kopie dient gebruikt te worden in de geüpgrade software.

• De regelaar dient van het meest recente besturingssysteem voorzien te worden.

• De parameterbestanden dienen (voorafgaand aan het opstarten na de upgrade van het 
besturingssysteem) in de regelaar teruggeplaatst te worden.

• Van de bestaande projectsoftware dienen alle onderdelen die niet standaard in de template 
aanwezig zijn geëxporteerd te worden.
Vervolgens dienen deze onderdelen geïmporteerd te worden in een lege template van de 
meest recente softwareversie.
Deze template wordt hierna opgeslagen om te gebruiken als nieuwe projectsoftware.

• De nieuwe projectsoftware dient naar de regelaar gestuurd te worden met CoDeSys.

• Controleer na het opstarten van de regelaar de parameterinstellingen en corrigeer deze waar
nodig.

Tijdens het upgraden van de regelaar wordt het besturingssysteem van de regelaar vervangen.

6 Afhankelijk van de orginele softwareversie kunnen, wegens het toevoegen van extra functionaliteiten, een deel van de instellingen 
verloren gaan.

16 / 26



 Copyright © 2014 HCS Building Automation Capelle aan den IJssel
Handleiding Updaten HCS3000

Bestandsversie: 1 Software-versie 1.10 / 1.11

Let op!!!!   Het besturingssysteem mag niet vervangen worden als deze nog 
actief is.
Vervangen van een actief besturingssysteem kan permanente schade 
opleveren aan het systeem.

Hierbij kan gebruik gemaakt worden van een FTP-verbinding om bestanden op het bestandsysteem 
van de regelaar te plaatsen, verwijderen en/of vervangen.

Voor het uitvoeren van een herstart en andere systeemacties kan gebruik gemaakt worden van een 
Telnet-verbinding.

De werking van de programma's Filezilla en PuTTY, die hiervoor gebruikt kunnen worden, staan 
omschreven in hoofdstuk 1.3 Te gebruiken programma's.

 4.2 Maken van regelaar-backup

Voordat werkzaamheden aan de regelaar uitgevoerd gaan worden, dient een volledige back-up 
gemaakt te worden van de inhoud van de regelaar.
Deze back-up kan indien nodig gebruikt worden om de originele staat van de regelaar te herstellen.

• Open een FTP-sessie ('Host' is 10.28.0.1, gebruikersnaam en wachtwoord zijn beide ftp, 
uitgaande van het standaard instellingen van de regelaar).

• Maak in het venster 'Lokale site' een nieuwe directory waarnaar de inhoud van de regelaar 
gekopieerd kan worden.

• Open de directory A: op de regelaar (in het venster 'Externe site') en download de volledige 
inhoud van de regelaar naar de PC.

• Sluit de FTP-sessie niet af.
Deze is in nodig voor het uitvoeren van de volgende handelingen.

De volledige inhoud van de regelaar is nu opgeslagen als back-up.

 4.3 Uitschakelen van het besturingssysteem

Om het besturingssysteem van de regelaar uit te schakelen dienen de volgende stappen uitgevoerd 
te worden:

• Open in de FTP-sessie de directory A en hernoem autoexec.bat naar autoexec.ba, of 
verwijder het bestand.

• Sluit de FTP-sessie door het programma te sluiten.

• Open een Telnet-sessie ('Host' is 10.28.0.1, gebruikersnaam en wachtwoord zijn beide tel, 
uitgaande van het standaard instellingen van de regelaar).

Toets het commando 'reboot' in en sluit af met enter om de regelaar te herstarten.

Door het herstarten van de regelaar zal de verbinding met de Telnetsessie verbroken 
worden.

De regelaar is nu opgestart, zonder dat het besturingssysteem actief is, en is gereed voor de 
volgende handelingen.
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 4.4 Formatteren van de regelaar

Na het uitschakelen van het besturingssysteem dient de inhoud van de regelaar gewist te worden.
Vanwege schrijfbeveiligingen op enkele bestanden dient hiervoor de A-schijf van de regelaar 
geformatteerd te worden.

• Open hiervoor een Telnetsessie en typ 'format a: /plp'.
Let hierbij op dat tussen a: en /plp een spatie dient te staan.
Bevestig met enter.

De regelaar zal vragen om een bevestiging van de keuze.
Na indrukken van de toets 'Y' zal de A-schijf geformatteerd worden.
Dit zal enige tijd in beslag nemen.

• Indien het formatteren gereed is, zal de regelaar hiervan een melding maken.

Let op!!!!   Maak de regelaar op dit moment niet spanningsloos!!!!

Indien de regelaar spanningsloos gemaakt wordt, zal het huidige IP-adres 
10.28.0.1 verloren gaan en kan de regelaar niet meer onder dit adres benaderd worden!
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• Om te controleren of het formatteren op de juiste manier is uitgevoerd, kan het commando 
'chkdsk' gebruikt worden.
Deze geeft de informatie van de A-schijf weer.

Let hierbij op dat in de eerste regel PLP aangegeven wordt.

Indien de tekst 'PLP' niet weergegeven wordt, dient het formatteren opnieuw 
uitgevoerd te worden.
Let hierbij op de spatie voorafgaande aan '/PLP'.

• Sluit de Telnet-sessie door het afsluiten van het programma PuTTY.

 4.5 Schrijven van besturingssysteem in regelaar

Nu de schijf van de regelaar leeg is, kan de image naar de regelaar gekopieerd worden.

• Open opnieuw een FTP-sessie en ga naar de directory A: van de regelaar.
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• Ga in het venster 'Lokale site' naar de directory 'C:\Program Files\3S Software\CoDeSys 
V2.3\Image HCS3000 V1.11.yy'. 
Dit is de directory waarin de inhoud van een 'schone regelaar' staat.
Hierbij staat yy in de directorynaam voor het buildnummer van de target.
De huidige buildversie is 16, zodat de volledige naam eindigt op '…....\CoDeSys V2.3\Image 
HCS3000 V1.11.16'. 

• Ga in het venster 'Externe site' naar de inhoud van A.

• Upload eerst het bestand 'chip.ini' van de image naar de regelaar, zodat na een eventuele 
spanningsuitval de regelaar het IP-adres 10.28.0.1 weer toegewezen krijgt.
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• Upload vervolgens de rest van de image naar de regelaar, met uitzondering van het bestand 
'chip.ini'. Dit uploaden zal enige tijd in beslag nemen. 

 4.6 Parameters terugplaatsen

De back-up van de regelaar bevat de parameterbestanden.
Deze parameterbestanden zijn herkenbaar aan de bestand-extenties .hpf en .hpb.

Om deze bestanden terug te plaatsen in de regelaar dienen de volgende stappen gevolgd te worden:

• Selecteer in 'Externe site' de subdirectory 'HCS3000' van de regelaar.

• Selecteer in het venster 'Lokale site' de back-up directory.

• Selecteer de subdirectory 'HCS3000'.
In het detailvenster van 'Lokale site' worden de bestanden getoond die in deze subdirectory 
aanwezig zijn.
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• Sorteer in de subdirectory 'HCS3000' de bestanden op basis van het bestandstype en 
selecteer vervolgens alle bestanden met bestand-extensie hpb en hpf.

• Upload geselecteerde bestanden naar de subdirectory 'A:/HCS3000'.

• Verbreek de FTP-verbinding door het programma af te sluiten.

 4.7 Opstarten van de regelaar

Na het schrijven van de image en de parameterbestanden dient de regelaar opnieuw opgestart te 
worden.

Volg hiervoor de volgende procedure.

• Open een Telnet-sessie en herstart de regelaar met het commando 'reboot' of maak de 
regelaar kortstondig spanningsloos. 

De regelaar zal hierna opstarten met het hiervoor geïnstalleerde besturingssysteem.

Na het opstarten is de regelaar klaar voor gebruik en kan met CoDeSys voorzien worden van de 
aangepaste projectsoftware.

 4.8 Upgraden van projectsoftware

Om de projectsoftware te upgraden, dient het originele projectbestand in CoDeSys geopend te 
worden.
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De onderdelen die ten opzichte van een lege template aangepast zijn en/of toegevoegd zijn aan de 
template, dienen geëxporteerd te worden.
Daarna kunnen deze geëxporteerde onderdelen geïmporteerd worden in een lege template, om 
zodoende het project in de nieuwe versie te maken.

 4.8.1 Exporteren van niet-standaard onderdelen

Om die onderdelen te exporteren die aangepast en/of toegevoegd zijn, dienen de volgende stappen 
gevolgd te worden.

• Open de projectsoftware in CoDeSys.
Indien de originele projectsoftware niet beschikbaar is, kan ook het bestand 'source.dat' uit 
de back-up-directory gebruikt worden als originele projectsoftware.

• Selecteer in CoDeSys in de menubalk 'Project → Export...', waardoor het dialoogscherm 
'Export Project' geopend wordt.

Selecteer de optie 'One file for each object', waardoor ieder object in een apart bestand 
geplaatst wordt.
Dit geeft later de mogelijkheid om een en ander per object terug te plaatsen.

• Selecteer de onderdelen die aangepast zijn en/of toegevoegd zijn.
Denk hierbij aan de I/O-lijst in de map 'Global Variables', 'Main_PRG' en 
'StandaardRamplotter' in 'POUs'.

Indien de regelaar onderdeel is van een netwerk van regelaars, dan dienen ook de lijsten 
met netwerkvariabelen geëxporteerd te worden.

Bij toepassing van aangepaste visualisaties, dienen ook deze geëxporteerd te worden.

Start het exporteren door op 'OK' te klikken.
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• Een tweede dialoogscherm opent zich, waarin de locatie te selecteren is waar de 
exportbestanden geplaatst zullen worden.

Indien de bestanden in een tijdelijke directory geplaatst moeten worden, dient deze directory 
voorafgaand aan het exporteren aangemaakt te worden.

Bevestig de locatie met 'OK', waarna de exportbestanden gegenereerd zullen worden.

 4.8.2 Toevoegen van bestanden aan lege template

De in hoofdstuk 4.8.1 geëxporteerde onderdelen kunnen verwerkt worden in een lege template.

Volg hiervoor de volgende stappen:

• Start het programma CoDeSys selecteer in de menubalk 'File → New from template...'.

• Selecteer in 'C:\Program Files\3S Software\CoDeSys V2.3\Projects' het bestand 'Template 
HCS3000 v1.11.pro' en bevestig met 'Openen'.

Hierdoor zal een nieuw projectbestand geopend worden, gebaseerd op de lege template.

• Sla de lege template op onder een nieuwe naam.

• Selecteer in de menubalk 'Project → Import...', waardoor het dialoogscherm 'Import Project' 
geopend wordt.

• Selecteer een exportbestand (of meerdere exportbestanden) en bevestig met 'Openen'.
Voor de onderdelen die in de template al bestaan, zal gevraagd worden of deze 
overschreven mogen worden.

Indien hier met 'Yes' of 'Yes, all' geantwoord wordt, zullen onderdelen in de template 
overschreven worden door de het geïmporteerde onderdeel met dezelfde naam.

Indien er met 'No' of 'No, all' geantwoord wordt, zullen de bestaande onderdelen in de 
template aanwezig zijn en de geïmporteerde onderdelen zullen toegevoegd worden, waarbij 
de naam van het toegevoegde onderdeel voorzien wordt van de oorspronkelijke naam met 
'_1' er aan toegevoegd.
'Main_PRG' zal in dit geval toegevoegd worden als 'Main_PRG_1', welke naast het reeds 
bestaande onderdeel 'Main_PRG' bestaat.

Dit laatste geeft de mogelijkheid om handmatig te controleren of alle onderdelen welke in de 
template aanwezig zijn en/of aangeroepen worden, ook in het geïmporteerde onderdeel 
aanwezig zijn en/of aangeroepen worden.

Na handmatige controle (en eventueel toevoegen van benodigde functies en/of aanroepen) 
kan het originele onderdeel verwijderd worden uit het project.
Hierna kan het geïmporteerde (en eventueel aangepaste) onderdeel hernoemd worden door 
de toevoeging '_1' uit de naam te verwijderen.

• Herhaal dit proces voor alle te importeren onderdelen.

 4.9 Upgraden van de software in de regelaar

Na het voltooien van de upgrade van de projectsoftware dient deze verstuurd te worden naar de 
regelaar.
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• Compileer de projectsoftware door het selecteren van 'Project → Clean all' en vervolgens 
'Project → Build all'.

• Sla het project op.

• Verstuur de projectsoftware naar de regelaar, maak het bootproject en start de 
projectsoftware op.

• Controleer de instellingen en corrigeer waar nodig.

 4.10 Controleren van systeeminstellingen

Bepaalde systeeminstellingen worden opgeslagen in het bestand 'chip.ini'.
In hoofdstuk 4.5 is dit bestand overschreven met het standaard chip.ini-bestand voor het nieuwe 
besturingssysteem.
Hierdoor kunnen de betreffende systeeminstellingen verloren zijn gegaan.

De volgende instellingen dienen handmatig teruggeplaatst te worden.

Instelscherm:

Instellingen → Algemeen Webpagina Titel

Instellingen → Algemeen Jar-bestanden beveiligen

Instellingen → Algemeen Secuur inloggen

Instellingen → Algemeen Instellingen voor tijdsynchronisatie

Instellingen → Netwerk Instellingen voor Intern IP adres, subnetmask en gateway

Instellingen → Netwerk Instellingen voor Extern IP adres of URL en poortnummer

Instellingen → Netwerk Instellingen voor Documentatie

Instellingen → Ramplotter Instellingen voor Maandplotter

Het wordt aangeraden om na het voltooien van de upgrade opnieuw een back-up van 
de inhoud van de regelaar te maken.
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